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For this exercise we will use
PTC Creo Parametric to model
a variety of 3D parts.




Starting with Creo Parametric

Start PTC Creo Parametric 3.0.
[

You may see some “Resource PTC Creo

Center” windows after starting i

Creo Parametric; if you do,

close them. i .
Click the New icon at the top e
left corner to create a new file. .

For this exercise, we are 4 |

creating a part. Make sure Part ]

IS selected, then enter a name —

(“partl™), and click OK. = e ——

 Use default template



After starting a new part, your screen will look like:
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The Ribbon Bar contains tools for making sketches,
extrusions, and other model operations.
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In the Graphics Area we see |25 R
three datum planes. In mathematics /\
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they would be called x, y, and —
z axes; in Creo they're referredto

as Top, Front, and Right planes. .




Sketching basics

The first step to creating a
model Is to create a Sketch. A
Sketch is a 2D projection of
part or all of the 3D model.

Click on Sketch in the ribbon
bar. The Sketch dialog pops
up, to determine what plane
to draw the sketch on.

In the graphics area, hover
the mouse over the border of
the Top plane until it is
outlined in green, then left-
click to select it.

Placement Properties
Sketch Plane
Plane
Sketch Orientation
Sketch view direction

Reference

Origntation




Click Sketch in the dialog box
to begin sketching on the
selected plane.

Sketch Crientation

Sketch wiewe direction | Flip

Reference FROMT:F1{DATURM PLARME)

Crientation | Bottom |

The ribbon bar changes to
display the Sketch tab.
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The Sketch tab contains many tools and shape primitives for
creating sketches, such as lines, circles, rectangles, ellipses,
etc.



Creating a shape

is Annotate Render Tools View  Flexible Modeling Applications
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Select the Center Rectangle
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Left-click in the graphics area '
to set the center of a rectangle.
Move the mouse pointer away B
from the center and click again
to form the rectangle. I
1

You'll be left with an orange
rectangle.

EIGHT




Although we have a rectangle,
it's not yet fully placed until it's
deselected. Either left-click on
the select tool, or middle-click to
deselect everything.

Line Center Center  Centerline | Cne-by- | Mormal

Chain and Poirt Rectangle [gl=]
Sketcher =

If the shape is properly “closed”,
it will turn solid orange.
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Changing the model view

As with assemblies, the mouse can be used to change the
view orientation of a part or sketch.

1. Dragging with the middle mouse button rotates the view.
2. SHIFT + middle mouse button pans the model view.

3. CTRL+D resets the model view to a “default” orientation.
4. The mouse scroll wheel will zoom the view in and out.*

5. When sketching, the Sketch View will orient the sketch
perpendicular to the screen. o 2 g ¢ o|lFa] &

7| .
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*Windows 10: If the mouse scroll wheel isn't working, be sure
“Scroll inactive windows” is turned off in Windows' Mouse settings.



Setting precise dimensions

When we freehand draw a shape, P IEEEAS

Its dimensions are not very precise.
The dimensions of our rectangle G
are given by four numbers here.

s

Two of the numbers represent the
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width and height of the rectangle. =~ .|
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The other two numbers are the
distance between a side and a
datum plane.

Double-click on any dimension (the blue numbers) to
explicitly set that dimension to a specific value.



For this exercise, set the
rectangle's width and height
both to 100.
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Adding to a sketch

Now we will add a circle to the ~Ol= | &~
SketCh . Lirme Center Center  Centerlime One-by-  Mormal

Chain |and Point | Rectangle One

Zketcher

Click the Circle tool in the ribbon

bar, then hover the mouse along |
the top edge of the rectangle / 1
until it snaps to the middle
(labeled “M™). |




Left click to set the center of the circle
at the rectangle edge's midpoint. |
Then drag the circle out to meet a b " Lotchlurcsys
rectangle corner such that a green
circle appears and it snaps into place.
Left-click again to place the circle. |

Middle click to deselect the circle.

The shape is no longer closed — it has |
Intersecting line segments — and o ET
therefore it is not solid orange. s et )
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We need to remove the extra line
segments.



Closing a shape

Click on the Delete Segment tool. EERONERER] | scer
_ Fillet = Eli Corner

LA Text
Left-click and drag the mouse over
any interior lines of the sketch. Each
line segment crossed will be deleted

Mare = Ediiting

from the sketch. e e
You may need to delete multiple ’fiwﬁ_lt
Interior segments. Any segments i

that are unconnected or extra are
marked with red boxes.

Continue until there arenomorered |~ | 1|
boxes, then middle click to finish. s .
The closed shape will fill orange. T

47203

I

[~ 100000 HE -
126 43




Extruding a shape

Now that our shape is finished, we can extrude it. Extruding a
shape gives it thickness, making it three-dimensional.

Click on the OK box to finish editing
the shape.

Press CTRL+D to see the shape In
its datum plane.

Left click on one of the shape's edges;
the shape's edges will turn green to

Indicate 1t has been selected.




Select the Extrude t00|-/' @
Extrude Rewvalve Sweep Blend Round Chamfer Shell  Hole  Freestyle =olidify  Sketch

Features

The object is now extruded into
three dimensions. The depth of
the extrusion is controlled by a
box in the Extrude ribbon bar.

The depth can also be controlled
by dragging the white box handle
In the graphics area.
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Set the extrusion depth to 20, Pacomont | ptions | ropertis
then select OK In the extrude -
ribbon. | Sl ol x



We now have a solid part.

Now we are going to extrude a new
feature onto our existing part.

Select the Extrude tool, then click the

£ s J Q) D =
top face of the part. Pod W& ¥ [

Extrude Rewolve Sweep Blend Round Chamfer Shell Hole

Creo immediately enters the Sketch

tool, and we are sketching on the
plane defined by the top face of our
part.




In Sketch mode, draw a 100 by 10
unit rectangle along the bottom
edge of the part.

As before, double-click on dimensions
to set them to exact values.

You can also drag on some dimension
arrows to adjust the value.

When the 100x10 rectangle is
correctly placed, click the green
checkbox.

drag



We have now added an extrusion
to the top face of our part.

Set the depth of this extrusion to 50
and click the green checkmark to
complete the extrusion.
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Extrude Rewolve Sweep Blend Round Chamfer Shell Hole

Now we will use an extrusion to
cut a hole in our part. Again click
the Extrude tool, and the top face

of our part.




Using the Circle tool, sketch a circle
near the rounded end of our part.

Click OK to complete the sketch.

Once again, we have an extrusion on
the top face of our part.

Drag on the white square to “push”
the extrusion into the part base.




Click on the “Remove Material” oA d[sm A A %
toggle in the Extrude ribbon bar. ’
This tells Creo to remove material

from the part instead of adding to it.

Click the green checkmark, and the
part now has a hole in it.

Another way to make holes is by
using the Hole Tool. It's often more

convenient. .
b P Y e

Extrude Rewolve Swweep Blend Round Chamfer Shel | Hole | Freestyle Zolidify  Sketch
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As with Extrude, the Hole Tool
starts by selecting a surface on
which to create the hole. Click
on the face of the rectangle we
extruded earlier.

Once selected, a cylinder appears
where the hole is to be placed. The
cylinder also has two green diamonds
used to set reference points for the
center of the hole.

Drag the green diamonds to edges
of the part. When both are set, the
orange cylinder becomes a hole.




As before, we can double-click on
blue dimensions to set them to
exact values, or drag white
sqguares to set dimensions.

Set the hole's diameter to 15, then - ey
click the green checkbox to finish the hole.

Editing existing features

On the left side of the window Is the d 057 e
Model Tree. It shows all of the features

In the current part.
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Right click on Hole 1 in the Model
Tree, then left click on Edit

Definition. The hole dimensions
appear again. Change the hole's
diameter to 5, then click the green
checkbox to finish.

Now start another hole on the same
surface with diameter 25. Exact
position isn't important.




Select Use standargl hole _ ;g imw vee mmes s Ul
profile in the Hole ribbon bar. | Des st e o il e o

This brings up the Countersink and Counterbore options.
These options cut away material around the entrace of the
hole so screws or bolts can recess below the surface.

Select the Counterbore option in the Hole ribbon. 7
The existing hole will appear larger.

To see the hole profile, select -

|<— 45.000 —>|

the Shape tab in the Hole ribbon. EEN -
Here the dimensions of the s g | e
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counterbore can be adjusted.
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Set the counterbore depthto 5, ™

then click the green check mark e <l
. o000 v L - 1
to accept the hole. Thisresults _—" L o
In a counterbore hole. ® srouir
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Using what you know, try creating the part below.
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Hint: Use the Shape tool to create the shape on the left,
Extrude that shape to a depth of 20, then add Holes in the

sides.
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Using what you know, try creating the part below.

@35, 00




Using what you know, try creating the part below.
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The Round and Chamfer tools work on edges of a solid.

either creating a rounded or beveled edge.

Start by creating a rectangular
block. This one is 100x100x30.

Select the Round tool, then click
on any edges to be rounded.

The amount of rounding is set by
the radius box.

‘:H:’ ,_| 5|:n:n:|

If multiple rounded edges meet at
a corner, it's rounded also.

-
R
&



Chamfer does the same as rounding
but produces beveled edges.

So far we've not assigned a unit to dimensions. To set a
model's dimensions, use File - Prepare — Model Properties:

Model Properties = 0 X

Material change

Unit= hange
Accuracy change

Mazs Properties e change I:\BI
[:j|= Relations, Parameters and Instances

Relations Mot defined e change | w
Parameters 3 defined e change I:\_.-':I
Instance Mot defined Active: Generic - CLAMP change

14 Faaturacs and Canmatne



To change the model's units,
select the new units and click Set. R —

Centimeter Gram Second (2G5 & Set...
Foot Pound Second (FPS)
= Inch lbm Second (Creo Parametric Def: Hew...

Inch Pouncd Second (IP3)

You're then given the option — i) )
of how to convert or interpret x| e

existing dimensions in the Model | parameters
mOdeI. e How do you want the model units to be changed ? e

@ Convert dimensions (for example, 1" becomes 25 .4mm)
Irterpret dimenszions (for example, 1" becomes 1mim)

Close

0K Cancel



Sending a part to a 3D printer

Most 3D printing software uses Stereolithography (.stl) files.

In PTC Creo Parametric, first save the part to disk, then

use File - Save As — Save a Copy and select
Stereolithography (*.stl) from the Type dropdown menu.

Save a Copy x
n - <« Uzers ¢ Public » Documents « |#¥| |Search...
Wl organize ~ EE views ~ T Tools ~ [zo

Common Folders

e DEzkiop

1 htyt CoocLament =

Folder Tree
Model Mame | CLAMPFRT
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STEP (* stp)

PATRAMN (* rtr)
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sl Stereolithography (%)

Imventor *.v)
Wigpeefront (*.obj)

In the Export STL dialog, enter
a small value for Chord Height.

Export STL X

Coordinate systern

[} Defaut

Farrmat
@ Binary Al

W Aoy negative values

Deviation control

- Chiord height | TETIERI

Angle cantrol: | 0500000

Step =size:



How to Model Almost Anything guide
- https://www.ptcusercommunity.com/docs/DOC-4618
- Section 3, Exercise 8: Sketching
- Section 3, Exercise 9: Personal Badge
- Section 3, Exercise 7: Part Model Planning


https://www.ptcusercommunity.com/docs/DOC-4618
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